Chapter 5: Creating a Table
In This Chapter
✓ Understanding table jargon
✓ Creating a table and entering the text and numbers
✓ Aligning table text in various ways
✓ Merging and splitting cells to make interesting layouts
✓ Changing the size of rows and columns
✓ Decorating a table with table styles, colors, and borders
✓ Doing math calculations in a Word table
✓ Discovering an assortment of table tricks

T

he best way to present a bunch of data at once in Word, PowerPoint, or
Publisher is to do it in a table. Viewers can compare and contrast the
data. They can compare Elvis sightings in different cities or income from
different businesses. They can contrast the number of socks lost in different
washing machine brands. A table is a great way to plead your case or defend
your position. On a PowerPoint slide, the audience can see right away that
the numbers back you up. In a Word or Publisher document, readers can
refer to your table to get the information they need.
As everyone who has worked on tables knows, however, tables are a chore.
Getting all the columns to fit, making columns and rows the right width
and height, and editing the text in a table isn’t easy. This chapter explains
how to create tables, enter text in tables, change the number and size of
columns and rows, lay out tables, format tables, and (in Word) do the math
in tables. You also discover a few tricks — including using a picture for the
background — that only magicians know. And to start you on the right foot,
I begin by explaining table jargon.

09_497487-bk01ch05.indd 81

3/25/10 8:35 PM

82

Talking Table Jargon

Talking Table Jargon
As with much else in Computerland, tables have their own jargon. Figure 5-1
describes this jargon. Sorry, but you need to catch up on these terms to construct the perfect table:
✦ Cell: The box that is formed where a row and column intersect. Each cell
holds one data item.
✦ Header row: The name of the labels along the top row that explain what
is in the columns below.
✦ Row labels: The labels in the first column that describe what is in
each row.
✦ Borders: The lines in the table that define where the rows and
columns are.
✦ Gridlines: The gray lines that show where the columns and rows are.
Unless you’ve drawn borders around all the cells in a table, you can’t tell
where rows and columns begin and end without gridlines. To display or
hide the gridlines, go to the (Table Tools) Layout tab and click the View
Gridlines button.
Row labels

Header row

Figure 5-1:
The parts of
a table.

Borders

Gridlines

Cells

Creating a Table
Word, PowerPoint, and Publisher offer several ways to create a table:
✦ Drag on the Table menu. On the Insert tab, click the Table button, point
in the drop-down list to the number of columns and rows you want,
click, and let go of the mouse button.
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✦ Draw a table (Word and PowerPoint). On the Insert tab, click the Table
button and then choose Draw Table on the drop-down list. The pointer
changes into a pencil. Use the pencil to draw table borders, rows, and
columns. If you make a mistake, click the Eraser button on the (Table
Tools) Design tab and drag it over the parts of the table you regret drawing (you may have to click the Draw Borders button first). When you
finish drawing the table, press Esc.
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✦ Use the Insert Table dialog box. On the Insert tab, click the Table
button and choose Insert Table on the drop-down list. The Insert Table
dialog box appears. Enter the number of columns and rows you want
and click OK. In PowerPoint, you can also open the Insert Table dialog
box by clicking the Table icon in a content placeholder frame.

You can click the Pen Color button and choose a color on the drop-down
list to draw your table in your favorite color.
✦ Create a quick table (Word). On the Insert tab, click the Table button
and choose Quick Tables on the drop-down list. Then choose a readymade table on the submenu. You have to replace the sample data in the
quick table with your own data.
✦ Convert text in a list into a table (Word). Press Tab or enter a comma
in each list item where you want the columns in the table to be. For
example, to turn an address list into a table, put each name and address
on its own line and press Tab or enter a comma after the first name, the
last name, the street address, the city, the state, and the ZIP Code. For
this feature to work, each name and address — each line — must have
the same number of tab spaces or commas in it. Select the text you’ll
convert to a table, click the Table button on the Insert tab, and choose
Convert Text to Table. Under Separate Text At in the Convert Text to
Table dialog box, choose Tabs or Commas to tell Word how the columns
are separated. Then click OK.

Constructing your table from an Excel worksheet
Fans of Microsoft Excel will be glad to know
that you can construct an Excel worksheet in
a Word document or PowerPoint slide. Excel
worksheets, which present data in columns
and rows, are very much like tables and can
serve as such in documents and slides.
To create an Excel worksheet, go to the Insert
tab, click the Table button, and choose Excel
Spreadsheet. An Excel worksheet appears
on the slide and — gadzooks! — you see
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Excel menus and commands where Word or
PowerPoint menus and commands used to
be. The worksheet you just created is embedded in your file. Whenever you click the worksheet, Excel menus and commands rather than
Word or PowerPoint menus and commands
appear on-screen. Click outside the worksheet
to return to Word or PowerPoint. Book VIII,
Chapter 7 explains how embedded objects
work.
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Entering the Text and Numbers

After you create a table, you get two new tabs on the Ribbon. The (Table
Tools) Design tab offers commands for changing the look of the table; the
(Table Tools) Layout tab is for changing around the rows and columns.

Entering the Text and Numbers
After you create the table, you can start entering text and numbers. All you
have to do is click in a cell and start typing. Select your table and take advantage of these techniques to make the onerous task of entering table data a
little easier:
✦ Quickly changing a table’s size: Drag the bottom or side of a table to
change its overall size. In Word, you can also go to the (Table Tools)
Layout tab, click the AutoFit button, and choose AutoFit Window to
make the table stretch from margin to margin.
✦ Moving a table: In Word, switch to Print Layout view and drag the table
selector (the square in the upper-left corner of the table). In PowerPoint
and Publisher, move the pointer over the table’s perimeter, and when
you see the four-headed arrow, click and drag.
✦ Choosing your preferred font and font size: Entering table data is
easier when you’re working in a font and font size you like. Select the
table, visit the Home tab, and choose a font and font size there. In Word
and PowerPoint, you can select a table by going to the (Table Tools)
Layout tab, clicking the Select button, and choosing Select Table on the
drop-down list.
✦ Quickly inserting a new row: Click in the last column of the last row
in your table and press the Tab key to quickly insert a new row at the
bottom of the table.
Here are some shortcuts for moving the cursor in a table:
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Press

Moves the Cursor to

Tab

Next column in row

Shift+Tab

Previous column in row

↓

Row below

↑

Row above

Alt+Page Up

Top of column (Word and PowerPoint)

Alt+Page Down

Bottom of column (Word and PowerPoint)
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Selecting Different Parts of a Table
✦ Selecting cells: To select a cell, click in it. You can select several adjacent cells by dragging the pointer over them.
✦ Selecting rows: Move the pointer to the left of the row and click when
you see the right-pointing arrow; click and drag to select several rows.
You can also go to the (Table Tools) Layout tab, click inside the row you
want to select, click the Select button, and choose Select Row on the
drop-down list. To select more than one row at a time, select cells in the
rows before choosing the Select Row command.

Creating a Table

It almost goes without saying, but before you can reformat, alter, or diddle
with table cells, rows, or columns, you have to select them:
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✦ Selecting columns: Move the pointer above the column and click when
you see the down-pointing arrow; click and drag to select several columns. You can also start from the (Table Tools) Layout tab, click in the
column you want to select, click the Select button, and choose Select
Column in the drop-down list. To select several columns, select cells in
the columns before choosing the Select Column command.
✦ Selecting a table: On the (Table Tools) Layout tab, click the Select
button, and choose Select Table on the drop-down list. In PowerPoint,
you can also right-click a table and choose Select Table on the shortcut
menu.

Aligning Text in Columns and Rows
Aligning text in columns and rows is a matter of choosing how you want the
text to line up vertically and how you want it to line up horizontally. Select
the cells, columns, or rows, with text that you want to align (or select your
entire table) and then align the text:
✦ In Word and Publisher: On the (Table Tools) Layout tab, click an Align
button (you may have to click the Alignment button first, depending
on the size of your screen). Word offers nine of them in the Alignment
group.
✦ In PowerPoint: On the (Table Tools) Layout tab, click one Horizontal
Align button (Align Left, Center, or Align Right), and one Vertical Align
button (Align Top, Center Vertically, or Align Bottom). You may have to
click the Alignment button first.
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Merging and Splitting Cells
Merge and split cells to make your tables a little more elegant than run-ofthe-mill tables. Merge cells to break down the barriers between cells and join
them into one cell; split cells to divide a single cell into several cells (or several cells into several more cells). In the table shown in Figure 5-2, the cells
in rows two, four, and six have been merged and a baseball player’s name
appears in each merged cell. Where rows two, four, and six originally had
nine cells, they now have only one.
Merge and split cells

Figure 5-2:
Merge cells
to create
larger cells.

Select the cells you want to merge or split, go to the (Table Tools) Layout
tab, and follow these instructions to merge or split cells:
✦ Merging cells: Click the Merge Cells button (in Word and PowerPoint,
you can also right-click and choose Merge Cells).
✦ Splitting cells: Click the Split Cells button (in Word and PowerPoint, you
can also right-click and choose Split Cells). In the Split Cells dialog box,
declare how many columns and rows you want to split the cell into and
then click OK. In Publisher, you can only split cells that were previously
merged.
In Word and PowerPoint, you can merge and split cells by clicking the Draw
Table or Eraser button on the (Table Tools) Design tab. Click the Draw Table
button and then draw lines through cells to split them. Click the Eraser
button and drag over or click the boundary between cells to merge cells.
Press Esc when you finish drawing or erasing table cell boundaries. You can
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click the Pen Color button and choose a color on the drop-down list to draw
in a particular color.

Laying Out Your Table

Creating a Table

Need to split a table? In Word, place the cursor in what you want to be the
first row of the new table, go to the (Table Tools) Layout tab, and click the
Split Table button.
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Very likely, you created too many or too few columns or rows for your table.
Some columns are probably too wide and others too narrow. If that’s the
case, you have to change the table layout by deleting, inserting, and changing the size of columns and rows, not to mention changing the size of the
table itself. In other words, you have to modify the table layout. (Later in this
chapter, “Decorating your table with borders and colors” shows how to put
borders around tables and embellish them in other ways.)

Changing the size of a table, columns, and rows
The fastest way to adjust the width of columns, the height of rows, and the
size of a table itself is to ”eyeball it” and drag the mouse:
✦ Column or row: Move the pointer onto a gridline or border, and when
the pointer changes into a double-headed arrow, start dragging. Tug and
pull, tug and pull until the column or row is the right size.
In Word and PowerPoint, you can also go to the (Table Tools) Layout
tab and enter measurements in the Height and Width text boxes to
change the width of a column or the height of a row. The measurements
affect entire columns or rows, not individual cells.
✦ A table: Select your table and use one of these techniques to change its
size in Word and PowerPoint:
• Dragging: Drag the top, bottom, or side of the table. You can also drag
the lower-right corner to change the size vertically and horizontally.
• Height and Width text boxes: On the (Table Tools) Layout tab, enter
measurements in the Height and Width text boxes. In Publisher,
these text boxes are found on the (Table Tools) Design tab. In
PowerPoint, click the Lock Aspect Ratio check box if you want to
keep the table’s proportions when you change its height or width.
• Table Properties dialog box (Word only): On the (Table Tools) Layout
tab, click the Cell Size group button, and on the Table tab of the
Table Properties dialog box, enter a measurement in the Preferred
Width text box.
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Adjusting column and row size
Resizing columns and rows can be problematic in Word and PowerPoint. For
that reason, Word and PowerPoint offer special commands on the (Table
Tools) Layout tab for adjusting the width and height of rows and columns:
✦ Making all columns the same width: Click the Distribute Columns
button to make all columns the same width. Select columns before
giving this command to make only the columns you select the same
width.
✦ Making all rows the same height: Click the Distribute Rows button to
make all rows in the table the same height. Select rows before clicking
the button to make only the rows you select the same height.
In Word, you can also click the AutoFit button on the (Table Tools) Layout
tab, and take advantage of these commands on the drop-down list for handling columns and rows:
✦ AutoFit Contents: Make each column wide enough to accommodate its
widest entry.
✦ AutoFit Window: Stretch the table so that it fits across the page
between the left and right margin.
✦ Fixed Column Width: Fix the column widths at their current settings.

Inserting and deleting columns and rows
The trick to inserting and deleting columns and rows is to correctly select
part of the table first. You can insert more than one column or row at a time
by selecting more than one column or row before giving the Insert command. To insert two columns, for example, select two columns and choose
an Insert command; to insert three rows, select three rows and choose an
Insert command. Earlier in this chapter, “Selecting Different Parts of a Table”
explains how to make table selections.
Go to the (Table Tools) Layout tab and follow these instructions to insert
and delete columns and rows:
✦ Inserting columns: Select a column or columns and click the Insert Left
or Insert Right button. If you want to insert just one column, click in a
column and then click the Insert Left or Insert Right button. You can
also right-click, choose Insert, and choose an Insert Columns command.
✦ Inserting rows: Select a row or rows and click the Insert Above or Insert
Below button. If you want to insert just one row, click in a row and click
the Insert Above or Insert Below button. You can also right-click, choose
Insert, and choose an Insert Rows command on the shortcut menu.
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To insert a row at the end of a table, move the pointer into the last cell
in the last row and press the Tab key.

✦ Deleting rows: Click in the row you want to delete, click the Delete
button, and choose Delete Rows. Select more than one row to delete
more than one. (Pressing the Delete key deletes the data in the row, not
the row itself.)

Creating a Table

✦ Deleting columns: Click in the column you want to delete, click the
Delete button, and choose Delete Columns on the drop-down list. Select
more than one column to delete more than one. (Pressing the Delete key
deletes the data in the column, not the column itself.)
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Sorting, or reordering a table (in Word)
On the subject of moving columns and rows,
the fastest way to rearrange the rows in a
Word table is to sort the table. Sorting means
to rearrange all the rows in a table on the basis
of data in one or more columns. For example,
a table that shows candidates and the number
of votes they received could be sorted in alphabetical order by the candidates’ names or in
numerical order by the number of votes they
received. Both tables present the same information, but the information is sorted in different
ways.
The difference between ascending and
descending sorts is as follows:
✓ Ascending arranges text from A to Z, num-

bers from smallest to largest, and dates
from earliest to latest.
✓ Descending arranges text from Z to A,

numbers from largest to smallest, and
dates from latest to earliest.
When you rearrange a table by sorting it, Word
rearranges the formatting as well as the data.
Do your sorting before you format the table.
Follow these steps to sort a table:
1. On the (Table Tools) Layout tab, click the
Sort button.
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You see the Sort dialog box. Depending on
the size of your screen, you may have to
click the Data button before you see the
Sort button.
2. In the first Sort By drop-down list, choose
the column you want to sort with.
3. If necessary, open the first Type dropdown list and choose Text, Number, or
Date to describe what kind of data you’re
dealing with.
4. Select the Ascending or Descending
option button to declare whether you want
an ascending or descending sort.
5. If necessary, on the first Then By dropdown list, choose the tiebreaker column.
If two items in the Sort By columns are
alike, Word looks to your Then By column
choice to break the tie and place one row
before another in the table.
6. Click OK.
When you sort a table, Word ignores the
header row — the first row in the table — and
doesn’t move it. However, if you want to include
the header row in the sort, click the No Header
Row option button in the Sort dialog box.
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Moving columns and rows
Because there is no elegant way to move a column or row, you should move
only one at a time. If you try to move several simultaneously, you open a can
of worms that is best left unopened. To move a column or row:

1. Select the column or row you want to move.
Earlier in this chapter, “Selecting Different Parts of a Table” explains
how to select columns and rows.

2. Right-click in the selection and choose Cut on the shortcut menu.
The column or row is moved to the Clipboard.

3. Insert a new column or row where you want the column or row to be.
Earlier in this chapter, “Inserting and deleting columns and rows”
explains how.

4. Move the column or row:
• Column: Click in the topmost cell in your new column and then click
the Paste button or press Ctrl+V.
• Row: Click in the first column of the row you inserted and then click
the Paste button or press Ctrl+V.

Formatting Your Table
After you enter text in the table, lay out the columns and rows, and make
them the right size, the fun begins. Now you can dress up your table and
make it look snazzy. You can change fonts, choose colors for columns and
rows, and even land a graphic in the background of your table. You can also
play with the borders that divide the columns and rows and shade columns,
rows, and cells by filling them with gray shades or a black background. Read
on to find out how to do these tricks.

Designing a table with a table style
The fastest way to get a good-looking table is to select a table style in the
Table Styles gallery, as shown in Figure 5-3. A table style is a ready-made
assortment of colors and border choices. You can save yourself a lot of formatting trouble by selecting a table style. After you’ve selected a table style,
you can modify it by selecting or deselecting check boxes in the Table Style
Options group.
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Select a table style
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Figure 5-3:
You have
many
opportunities
for
designing
tables.

Click anywhere in your table and follow these steps to choose a table style:

1. Go to the (Table Tools) Design tab.
2. Open the Table Styles gallery and move the pointer over table style
choices to “live-preview” the table.
In Publisher, this gallery is called Table Formats.

3. Select a table style.
To remove a table style, open the Table Styles gallery and choose Clear
(in Word) or Clear Table (in PowerPoint).
For consistency’s sake, choose a similar table style — or better yet the same
table style — for all the tables in your document or presentation. This way,
your work doesn’t become a showcase for table styles.

Calling attention to different rows and columns
On the (Table Tools) Design tab, Word and PowerPoint offer Table Style
Options check boxes for calling attention to different rows or columns (refer
to Figure 5-3). For example, you can make the first row in the table, called
the header row, stand out by selecting the Header Row check box. If your
table presents numerical data with total figures in the last row, you can call
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attention to the last row by selecting the Total Row check box. Select or
deselect these check boxes on the (Table Tools) Design tab to make your
table easier to read and understand:
✦ Header Row and Total Row: These check boxes make the first row and
last row in a table stand out. Typically, the header row is a different
color or contains boldface text because it is the row that identifies the
data in the table. Click the Header Row check box to make the first row
stand out; if you also want the last row to stand out, click the Total Row
check box.
✦ Banded Columns and Banded Rows: Banded means “striped” in Office
lingo. For striped columns or striped rows — columns or rows that alternate in color — select the Banded Columns or Banded Rows check box.
✦ First Column and Last Column: Often the first column stands out in a
table because it identifies what type of data is in each row. Select the
First Column check box to make it a different color or boldface its text.
Check the Last Column check box if you want the rightmost column to
stand out.

Decorating your table with borders and colors
Rather than rely on a table style, you can play interior decorator on your
own. You can slap color on the columns and rows of your table, draw borders around columns and rows, and choose a look for borders. Figure 5-4
shows the drop-down lists on the (Table Tools) Design tab that pertain to
table decoration. Use these lists to shade table columns and rows and draw
table borders.
Line Style (Pen Style) list
Shading button

Borders button

Line Weight (Pen Weight) list

Figure 5-4:
Tools on
the (Table
Tools)
Design
tab for
decorating
tables.
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Designing borders for your table
Follow these steps to fashion a border for your table or a part of your table:

To select the entire table, go to the (Table Tools) Layout tab, click the
Select button, and choose Select Table.

3. Open the Line Style drop-down list (in Word) or the Pen Style drop-

Creating a Table

1. Go to the (Table Tools) Design tab.
2. Select the part of your table that needs a new border.
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down list (in PowerPoint) and choose a line style for the border (you
may have to click the Draw Borders button first, depending on the
size of your screen).
Stay away from the dotted and dashed lines unless you have a good
reason for choosing one. These lines can be distracting and keep others
from focusing on the data presented in the table.

4. Open the Line Weight drop-down list (in Word and Publisher) or the
Pen Weight drop-down list (in PowerPoint) and choose a thickness for
the border (you may have to click the Draw Borders button first).

5. If you want your borders to be a color apart from black, click the Pen
Color button (Word and PowerPoint) or the Line Color button
(Publisher) and choose a color on the drop-down list (you may have to
click the Draw Borders button first).

6. Open the drop-down list on the Borders button and choose where to
place borders on the part of the table you selected in Step 2.
This is the tricky part. The Borders commands have different effects,
depending on which part of the table you selected. For example, if you
selected two rows and you choose the Top Border command, the command applies only to the top of the uppermost row. If you are anywhere
near typical, you have to repeat Step 6 until you get it right.
In Word, you can also change borders by clicking the Draw Borders group
button and making selections in the Borders and Shading dialog box, as
shown in Figure 5-5.
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Figure 5-5:
In Word,
you can
draw
borders with
the Borders
and Shading
dialog box.

Selecting colors for columns, rows, or your table
Follow these steps to paint columns, rows, or your table a new color:

1. Select the part of the table that needs a paint job.
2. In the (Table Tools) Design tab, open the drop-down list on the
Shading button and choose a color (refer to Figure 5-5).
This button is called Fill in Publisher.
Later in this chapter, “Using a picture as the table background” explains how
to use a picture as the background in a table.

Using Math Formulas in Word Tables
No, you don’t have to add the figures in columns and rows yourself; Word
gladly does that for you. Word can perform other mathematical calculations
as well. Follow these steps to perform mathematical calculations and tell
Word how to format sums and products:

1. Put the cursor in the cell that will hold the sum or product of the cells
above, below, to the right, or to the left.

2. On the (Table Tools) Layout tab, click the Formula button.
Depending on the size of your screen, you may have to click the Data
button first. The Formula dialog box appears, as shown in Figure 5-6. In
its wisdom, Word makes an educated guess about what you want the
formula to do and places a formula in the Formula box.
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Figure 5-6:
A math
formula in a
table.

3. If this isn’t the formula you want, delete everything except the equal
sign in the Formula box, open the Paste Function drop-down list, and
choose another function for the formula.
For example, choose PRODUCT to multiply figures. You may have to
type left, right, above, or below in the parentheses within the formula
to tell Word where the figures that you want it to compute are.

4. In the Number Format drop-down list, choose a format for your
number.

5. Click OK.
Word doesn’t calculate blank cells in formulas. Enter 0 in blank cells if
you want them to be included in calculations. You can copy functions from
one cell to another to save yourself the trouble of opening the Formula
dialog box.

Neat Table Tricks
The rest of this chapter details a handful of neat table tricks to make your
tables stand out in a crowd. Why should all tables look alike? Read on to
discover how to make text in the header row stand on its ear, put a picture
behind a table, draw diagonal border lines, draw on top of a table, and wrap
slide text around a table.

Changing the direction of header row text
In a top-heavy table in which the cells in the first row contain text and the
cells below contain numbers, consider changing the direction of the text in
the first row to make the table easier to read. Changing text direction in the
first row is also a good way to squeeze more columns onto a table. Consider
how wide the table shown in Figure 5-7 would be if the words in the first row
were displayed horizontally.
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Figure 5-7:
Change the
direction
of text to
squeeze
more
columns on
a table.

Follow these steps to change the direction of text on a table.

1. Select the row that needs a change of text direction.
Usually, that’s the first row in a table.

2. Go to the (Table Tools) Layout tab.
3. Click the Text Direction button.
What happens next depends on whether you’re operating in Word,
Publisher, or PowerPoint:
• In Word and Publisher: Keep clicking the Text Direction button until
text lands where you want it to land. (You may have to click the
Alignment button before you can see the Text Direction button.)
• In PowerPoint: Choose a Text Direction option on the drop-down
list. (You may have to click the Alignment button to get to the Text
Direction button, depending on the size of your screen.)

4. Change the height of the row to make the vertical text fit.
As “Changing the size of a table, columns, and rows” explains earlier in
this chapter, you can change the height of a row by going to the (Table
Tools) Layout tab and entering a measurement in the Height box.

Using a picture as the table background
As Figure 5-8 demonstrates, a picture used as the background in a table
looks mighty nice. To make it work, however, you need a graphic that serves
well as the background. For Figure 5-8, I got around this problem by recoloring my graphic (Book VIII, Chapter 3 explains how to recolor a graphic.) You
also need to think about font colors. Your audience must be able to read the
table text, and that usually means choosing a white or light font color for
text so that the text can be read over the graphic. For Figure 5-8, I selected a
white font color.
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Figure 5-8:
Using a
graphic
as a table
background
(left) and
placing
the same
graphic in
all table
cells (right).

Besides putting a graphic behind a table, PowerPoint gives you the opportunity to make the graphic appear in every table cell, as shown on the right
side of Figure 5-8. Sorry, you can’t do that feat in Word, but you can place a
picture behind a table, as the following pages explain.

Placing a picture behind a table
Placing a graphic behind a table requires a fair bit of work, but the results
are well worth the effort. First you insert the graphic and perhaps recolor it.
Then you create the table. Last, you make the table fit squarely on top of the
graphic and perhaps group the objects together.
In Word and PowerPoint, follow these steps to place a graphic behind a
table:

1. Insert the graphic, resize it, and format the graphic.
Book VIII, Chapter 3 explains how to insert and resize graphics. To insert
a graphic, go to the Insert tab and click the Picture button. To resize it,
drag a selection handle; make the graphic as big as you want your table
to be. To recolor a graphic similar to the job done to the graphic in
Figure 5-8, select the (Picture Tools) Format tab, click the Color button,
and choose an option.

2. Insert the table and make it roughly the same size as the graphic.
These tasks are explained earlier in this chapter. To change the size
of a table, drag a selection handle on its corner or side. Place the table
nearby the graphic, but not right on top of it.
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3. On the (Table Tools) Design tab, open the Table Styles gallery, and
choose Clear (in Word) or Clear Table (in PowerPoint).
With the table styles out of the way, you can see the graphic clearly
through your table.

4. Enter the data in the table, select a font and font color, select a border
and border color, and align the text.
These tasks (except for selecting fonts) are described throughout this
chapter. The easiest way to choose a font and font color for a table is to
select the table, go to the Home tab, and select a font and font size.

5. Move the table squarely on top of the graphic and then make the table
and graphic roughly the same size.
Here are a few tricks that are worth knowing when you’re handling a graphic
and table:
✦ In Word, you have to turn off text wrapping in order to bring the graphic
behind the table. To do that, select your graphic, go to the (Picture
Tools) Format tab, click the Wrap Text button, and choose Behind Text
on the drop-down list.
✦ If the graphic is in front of the table, select the graphic, go to the
(Picture Tools) Format tab, open the drop-down list on the Send
Backward button, and choose Send to Back (in PowerPoint) or Send
Behind Text (in Word).
✦ To make the graphic and table the same size, enter the same measurements for both. Select the table, go to the (Table Tools) Layout tab, and
enter measurements for the table in the Height and Width boxes. Then
select the graphic, go to the (Picture Tools) Format tab, and enter the
same measurements in the Height and Width boxes (you may have to
click the Size button to see these boxes, depending on the size of your
screen).

Placing a background picture in each PowerPoint table cell
PowerPoint offers a special command for placing a picture in each table
cell (refer to Figure 5-8). For this trick to work, you need a graphic of uniform color; otherwise, the text is too hard to read. (You might consult
Book VIII, Chapter 3, which explains how to alter graphics with the Office
Picture Manager.) Follow these steps to place a background picture in each
PowerPoint table cell:

1. Right-click your table and choose Select Table.
2. Go to the (Table Tools) Design tab.
3. Open the drop-down list on the Shading button and choose Picture.
The Insert Picture dialog box opens.
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4. Select a picture and click the Insert button.

Drawing diagonal lines on tables
Draw diagonal lines across table cells to cancel out those cells or otherwise
make cells look different. In Figure 5-9, diagonal lines are drawn on cells to
show that information that would otherwise be in the cells is either not available or is not relevant.

Creating a Table

To remove the background pictures from a table, open the drop-down
list on the Shading button and choose No Fill or choose Clear Table in
the Table Styles gallery.

Book I
Chapter 5

Figure 5-9:
Diagonal
lines mark
off cells as
different.

Go to the (Table Tools) Design tab and use one of these techniques to draw
diagonal lines across cells:
✦ Draw Table button: Click the Draw Table button (you may have to click
the Draw Borders button first). The pointer changes into a pencil. Drag
to draw the diagonal lines. Press Esc or click the Draw Table button a
second time when you’re finished drawing.
Click the Pen Color button and choose a color before drawing on your
table if you want the diagonal lines to be a certain color.
✦ Borders button: Select the cells that need diagonal lines, open the dropdown list on the Borders button, and choose Diagonal Down Border or
Diagonal Up Border.
To remove diagonal lines, click the Eraser button and click or drag across
the diagonals.

Drawing on a table
When you want to call attention to data in one part of a table, draw a circle
around the data. By “draw” I mean make an Oval shape and place it over
the data you want to highlight, as shown in Figure 5-10. Book I, Chapter 8
explains the drawing tools in detail. To spare you the trouble of turning
to that chapter, here are shorthand instructions for drawing on a table in
Word, PowerPoint, and Publisher:

09_497487-bk01ch05.indd 99

3/25/10 8:36 PM

100

Neat Table Tricks
1. On the Insert tab, click the Shapes button and select the Oval shape
on the drop-down list.

Figure 5-10:
You can
circle data to
highlight it.

2. On a corner of your page or slide, away from the table, drag to draw
the oval.

3. On the (Drawing Tools) Format tab, open the drop-down list on the
Shape Fill button and choose No Fill.

4. Open the drop-down list on the Shape Outline button and choose a
very dark color.

5. Open the drop-down list on the Shape Outline button, choose Weight,
and choose a thick line.

6. Drag the oval over the data on your table that you want to highlight.
If the oval is obscured by the table, go to the (Drawing Tools) Format
tab, and click the Bring Forward button (click the Arrange button, if necessary, to see this button). While you’re at it, consider rotating the oval
a little way to make it appear as though it was drawn by hand on the
table.
In the course of a live PowerPoint presentation, you can draw on slides with
the Pen to highlight data. See Book IV, Chapter 4.
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